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AUSTRALIA-INDONESIA SCHOOL PARTNERSHIPS

How To: Create a Virtual Field Trip Using Google Earth

Introduction

The following instructions will show you how to create a Virtual Field Trip using Google Earth. The
software is free and relatively easy to use which will allow most teachers to be able to put
something together for classroom use that can be shared among students or colleagues. A Virtual
Field Trip can bring the world to your students without you having to leave your computer room —
you could even run a Virtual Field Trip from a regular classroom if you have access to a laptop and a
data projector. Consider the possibilities and even check out what Virtual Field Trips other teachers
have created and placed online already — there is no need to reinvent the wheel!

Step 1: Download Google Earth

To get started you will need to download the software and install it on your computer. If you are in a
school environment you may need administrator privileges to do this so you should consult your IT
Department for advice. At home you should be able to do this without any problems.

Go to the Google Earth download page at http://earth.google.com/ and click on the following link.

Download Google Earth 5.0

The world's geographic information at your fingertips.

Once you have downloaded the install file to your computer, double click on the
GoogleEarthSetup.exe file (See below) to install the software. The default installation settings and
locations are fine but feel free to change these to suit your needs.

=" { GoogleEarthSetup
' 5 ‘;';&tu;:
Google Inc.




Step 2: Review Google Earth Supporting Materials
There is an amazing amount of material online to help you use and get the most out of Google Earth.
Only a small selection of official Google sites have been provided here so use your search engine to

find more if needed.

Google Earth Help — The main Google Earth Help page, from here you can get basic help or find links

to other sites that can answer more specific questions

http://earth.google.com/support/

Google Earth User Guide — The Google Earth User Guide from Google. This page has the ins and outs

of getting the most out of Google Earth from basic user instructions through to advanced techniques

for using the software.

http://earth.google.com/support/bin/topic.py?topic=17090

Google Earth Help Forum — The new Google Earth Help Forum, you can post a question here and

experts as well as expert users will respond with advice. Very useful.

http://www.google.com/support/forum/p/earth?hl=en

There are also some fantastic ‘fan pages’, while not officially endorsed by Google they still offer
great advice as tips.

Unofficial Google Earth Blog — As the title suggests, a blog about Google Earth by a non-Google user.

Lots of useful updates and information provided here.

http://www.gearthblog.com/

@_ Google Earth Blog

The amazing things about Google Earth™...

About | Basics | Links | Tips | 3D Models | Videos | SightSeeing | Gallery | Sky

All about Google Earth: news, features, tips, satellite photos, and applications.

Site Search
Major news! Google Earth 5 Out! - Initial look (Ocean) | Mars | Videos | Historical imagery
Big News: Vancouver in 3D | New Ocean Floor Imagery | New York City in 3D (5]

February 06, 2009
Links marked with this icon
Google Earth 5 - More News Roundup sre Google Earth files. You must

have Google Earth installed to use
Naturally, the biggest week in Google Earth news history, and I'm on a big trip with limited these links.

Internet access! It looks like I won't have time today to do in-depth analysis, but here's a
round-up of some of the best new news and observations from other Google Earth experts:

GETTING
STARTED
« New GPS Support - Google eliminated the Google Earth Plus product in December. The

GPS support in Plus is now available in the free version of Google Earth. About Google Earth Blog
FreeGeographyTools was probably first in commenting on this, and here's Google's post Download Google Earth
about it.

GE Basics

« More on Mars - This is Google's post on the new Mars mode in Google Earth 5. The post
acknowledges that this project was part of the agreement NASA and Google made a
couple of years ago.

GE Home Page

GE Community

GE Help
« More on Tour Features - The Record Tour is a major new feature in GE 5. Here's Google Earth Blog in Spanish
Google's post about the Touring. This post is by Googler Dan Barcay who was a prime RSS Feed
ee

player in the tour feature development. Lots of interesting tips, links to references, and
examples. Here are some observations from design expert Richard Treves_including his
E—— — LSS RS S MRS —




Step 3: The Basics of Google Earth

Google Earth is relatively simple to use although, like any new software, it does take some time.
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Add Content — These tools
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Show Historical Imagery —

Access historical imagery for

an area and view change over

time

3D Viewer — This
is the ‘map’ part
of Google Earth

There are also many ‘keyboard shortcuts’ that you can take advantage of to help make the software
easier to use. Keyboard shortcuts are simply keys that you can use to save you using buttons and
tools from within the software. You can find an extensive list at

http://earth.google.com/userguide/v5/ug keyboard.html.

The main keys you should initially use are summarised in the table below.

ArowKeys
Shift + Left/Right Arrow

Shift + Left Mouse Button (and Drag Upor Down)
Mouse Scroll Button

nkey
u Key

Spend some time simply playing with the software. Search for your location and zoom and pan
around the map. Practice tilting the map to get a more 3D view and experiment with some of the
other features, such as historical maps if they are available in your area.




Step 4: Organise Your Folders

You should have a folder set up on your hard drive somewhere to save all of

¥ Places Add Content . i i
S W& My Places your work to — you will do this later. However, you will also need to create a
2/ starting Location specific folder for your Virtual Field Trip from within Google Earth. To the left

+ [l ED Sightseeing
Select this folder and click on the

" 1 of your screen you should see a Places section (if it is too small, you can

Play' butt

. a% BE'""WBL'l expand it by dragging). In here, right-click your mouse on the Temporary
= emporary Places
V]ED School and Sydney Tour Places folder. Select Add = Folder and in the new dialogue box that opens,

This Virtual Field Trip start at

our school and pass th

insert the name of your Virtual Field Trip as well as a short description for you

and anyone else who may view the Virtual Field Trip.

Place a checkmark in the ‘Allow this folder to be expanded’ Google Earth - Edit Folder B

field but leave the ‘Show contents as options’ field
RO chool and Sychey Tour

. . . . . R B |v] Allow this folder to be expanded
at as the view associated with the Virtual Field Trip. This [E] Show contents as options (radio button selection)

unchecked. The View tab will save the view you are looking

means that when you begin the Virtual Field Trip it will start

Description View

from this view, so navigate to an appropriate view extent Desaription:
and when you are ready, hit OK. You can edit the view, D o srart ot our schooland pass trough some of

description and name later if you wish (right-click on the

folder and select Properties).

| will create a small tour showing a school in Sydney as well
as some of the main icons of the city as an example. The
image above shows you how this folder will look in the
Places section of Google Earth. You can create a tour that
covers just your city/town or that stretches across the
whole planet — there really is no limit to the extent of the
Virtual Field Trip.




Step 5: Place Placemarks

You will now create your individual placemarks for each stop on your Virtual Field Trip. Create these
inside the folder you created in the previous step. The order in which you create the placemarks
does not matter now as you can edit the order later but be aware that the Virtual Field Trip will play
through the placemarks from top to bottom as they are listed in the folder. To give you an example, |
will create placemarks for the following:

* My School

* The Sydney Harbour Bridge
* The Sydney Opera House

* BondiBeach

* Taroonga Zoo

The Placemarks will be created in the order listed and the Virtual Field Trip will follow that order
when complete.

To create a Placemark, simply right-click on your Virtual Field Trip folder (School and Sydney Tour in
this example) and select Add—=> Placemark (as can be seen in the image, below). You can then drag
the pushpin icon to your exact location and begin to edit the placemark content; although just
create the placemarks now with a descriptive name (leave default settings) and we will edit content
in the next step.

Folder

Co
& Path

Delete
Delete Contents e
Model
Rename Tour
Save to My Places Photo
Save Place As... Image Overlay
Share / Post... i
¥ Places - Network Link
—]@ Berlin Wal
= VI Temporary Snapshot View
& [VI&3 School an

This Virtu Properties
at our school and pass througF|
4 My School
4 Sydney Harbour Bridge
17 Sydney Opera House
/' Bondi Beach

SISISS




Step 6: Edit Placemark Content
Once you have created the placemarks, you will want to change how they look and add some
content to each to make them a little more interesting. You can add any amount of text as well as
images or hyperlinks to each placemark, although you should consider placing an appropriate
amount of information at each point so as not to bore
your students.

Now go back to your first Placemark by double-clicking
on it in your Places section. Google Earth will zoom to the
extent you were viewing when you saved the Placemark.
During your Virtual Field Trip, the map will zoom back to
this extent so zoom in or out to get this right. For an
example, see the image to the right showing my school

and the extent it will be seen in the example Virtual Field

Trip. Note that is does not have to be oriented with

Google Earth - Edit Placemark =]

North to the top of the map and you can also tilt your map to
provide a different viewpoint. Neme: | IS

Latitude: 33°48'16.07"S
Longitude: | 151°9'19.08"E

To change this extent, right-click on the Placemark under the
Places section. Zoom to the extent you want your Placemark set Descrpton | Stye, Coor | View [ e

[7] center in View

at and then, under the View tab, hit the Snapshot Current
Extent button to save this extent. See the image to the right for

assistance.

33.000000°
42.000000°

Date/Time: None E|

You can also edit the icon of the Placemark that is used to
identify your locations. To the right of the name field there is a
small Placemark icon. Click this button to see all of the options

. . . . Snapshot it Reset
available to you, just make sure you select appropriate icons for oot ot v = (pet ]
the different features you are mapping.

Finally you will want to edit the content of the Placemark so that when the Placemark is clicked it
shows the user useful information. You can enter text as well as images and hyperlinks to websites.
So if you have a video, it is best to upload it to a video hosting website (www.teachertube.com or

www.youtube.com, but be aware that many schools ban Youtube now) and then place a link to the

video in your Placemark.

All of the visible content in the Placemark is contained in the Description area of the Placemark and
HTML coding is used to create more advanced elements, such as hyperlinks and images, in this
Description area.



There are some rules as to how you should enter data into the Description filed to help you properly
format your information. The table below summarises some of the main HTML code that you will
need to use but if you have knowledge of HTML feel free to experiment and see what you can do.
Note that the text in red will need to be changed by you to suit your specific needs.

<BR> Inserts a break into your page

<CENTER> and </CENTER> Opens and closes text/object centring

<IMG SRC=" "> Inserts an image from a website, note the URL
is required

<IMG SRC=* " WIDTH="00¢" HEIGHT= “00¢"> Inserts and resizes an image from a website,

note that you need to manually enter the
value of pixels to resize he image to.

<A HREF=“ Inserts a hyperlink

By entering the following text into the Description field, | was able to get the Placemark content to
look like the screen capture further down the page. Note that the image links to a website image
and it has not been resized; you could make it smaller or larger if you wish.

This centres This is the URL

the image for the image
<CENTER>
<IMG SRC="http://farm1.st@ic.flickr.com/60/173307180_9ba53f8796.jpg">
</CENTER>
<BR> @— These breaks place gaps between
This is one of the playgrounds at my school. elements (ie the image and text)
<BR>
<A HREF="http://www.mogbray-p.schools.nsw.edu.au/frameset.htm">Mowbhray Park State
School</A>

<BR> @—__

A final break neatens This is the web address

off your content for the hyperlink This is the text that

will appear to be
clicked on



This is one of the playgrounds at my school.
Mowbray Park State School

Directions: To here - From here

elevh 56,m Eyealt . 288m




Step 7: Managing Images
Managing your images is crucial to your Virtual Field Trip as you could save your Virtual Field Trip
without your images by accident. Follow the steps below to make sure that when you save a Virtual

Field Trip it will save all images as well.

Online Images

In the previous example you used an image from the internet to insert into your Placemark. You can
take your own images and upload them to one of many websites that will freely host images and
then link through to this website if you wish. Some websites that offer this service include,

e http://www.flickr.com
e http://photobucket.com/

e http://www.snapfish.com/ snupf.Sh :: flickr
e http://www.facebook.com facebook photobucliét

* http://www.myspace.com

e http://www.bebo.com

Remember that you can also link to images on other websites (for example you might want to use an
image from your school’s homepage in your Google Earth Placemark) by placing the URL in the

relevant section in the Description field (see previous step).

Using Your Own Images

You can also include images that are saved onto your computer in your Google Earth Placemarks
however, many users have noted some problems with this method. The image is saved within your
.kmz file which can massively increase the size of these files, making them too large to email or even
copy. Secondly, some users have found that the images do not reliably save to the .kmz file meaning
that when they are needed in the future, they simply do not open. If you are linking to an image on
your computer and you then save your .kmz file to be used elsewhere, | would strongly recommend
you test and retest the .kmz file on a number of other machines to make sure that it will work for
you — there is nothing worse than expecting a wonderful image to show up (especially in class!)
when nothing in fact does pop up for you. For more information on .kmz files, see the following

steps.



Step 8: Saving Placemarks as .kml Files ¥ Places dd Content

[[1& Berlin Wall -
e ithi 2 VS Te Pl
Once you have completed editing the content within each of your e ACUA—
. . This Virtual Field Trip will start at our
Placemarks, you can begin the process of saving your work. Before you Schooland pass thicugh someof

) A VI@ My School
begin make sure you have a folder set up somewhere on your hard drive

to save all of your work into. WI0D Sxdney Harbour Bidge

V(D Sydney Opera House

This starts by saving each Placemark individually. The image to the right
shows the completed folder configuration for my Virtual Field Trip. Note
that the Placemarks are in the order in which | want to VFT to take place. @0 rongaZeo

m

M Bondi Beach

If this order is not correct, you should click and drag the Placemarks up or
down to get the desired result. =

Now simply right-click on the first Placemark, in my case My School, and select ‘Save Place As...".

You should navigate to the folder on your hard drive in which you will save your work (you set this

up in step 4) and save the file as a .kml file. It is best to call the file what you have called it in Google
Earth to remove confusion.

& Save file.. léj
U\J [1) « AEFTesting » Final FVT ~ [ 4 ||| search )
Wy Organize v 222 Views v W New Folder ©)
Name/ Date modified Type »
[E| Documents (DT
v & | My School
5l Recent Places X
& | Sydney Harbour Bridge
f Deskiop & | Sydney Opera House
1% Computer ST z
& | Taronga Zoo
Change the % Recently Chagged
- Pictures
filetype to .kml i Picture
m Music
here B Searches
Public
Folders ~
File name: My School '\ -
Save as type: |Kml (*.kml) v]
4 Hide Folders Save Cancel

Do this for all of your Placemarks so they are all saved in the one folder on your hard drive. These
can be opened in future, using the File=>Open option in Google Earth but as .kml files they will only
open individually. You will save your Virtual Field Trip in the next step.



Step 9: Saving Your Tour as a .kmz File

Once all placemarks have been saved, you will save your Virtual
Field Trip as a ‘package’ using the .kmz file format. In step 4 you
created a folder, within Google Earth, to house all of your
Placemarks. In the example provided to the right it is the ‘School
and Sydney Tour’ folder.

Right click on this folder and click on ‘Save Place As...” again. This
time you will need to change the file type to .kmz. See the example
below.

¥ Places Add Content

(1§ Berlin Wall -

GuenPBTaTy Places
V| & School and Sydney Tour
This Virtual Field Trip will start at our
school and pass through some of

JO Sydney Harbour Bridge

VIO Sydney Opera House

m

¥I(D BondiBeach

() TerongaZoo

S Y Rl School and Sydney Tou

v

Save as type: [sz (*.kmz)

7

“« Hide Folders

Save

] [ Cancel ]

This will package all of your Placemarks into a portable file that you can copy and move to other

computers. In theory, any images that you have included from your computer will also be included
within this file (although there have been problems reported with this method, see step7 for more
information). If you have included links to internet images in your .kmz file you will need to ensure

that any other computers you are using have access to the internet to be able to display those

images.

Once you have saved your .kmz file it is advisable to close down Google Earth and reopen the
software to test your new file. Once you have reopened Google Earth, go to File=>Open and
navigate to your recently saved .kmz file. Open it and see if all of the Placemarks are working as you

saved them.




Step 10: Playing Your Tour

Playing and using your tour is easy. This is really the step your students will take if you have created
a Virtual Field Trip for them to use in class. Once you have opened your .kmz file in Google Earth it
should display as in the image below. You will see the.kmz file with a folder underneath that has the
same name. Inside that folder, all of your Placemarks will be visible.

¥ Places Add Content
& VI3 Temporary Places -
= V& School and Sydney Tourkmz
& [V €9 School and Sydney Tour
This Virtual Field Trip will
start at our school and pass

¥ @ My School
C] Sydney Harbour Bridge

C] Sydney Opera House

m

C] Bondi Beach

C] Taronga Zoo

(=)

a—t

To play the Virtual Field Trip, click on the Folder (not the .kmz file name) and hit the Play Tour
button, circled in the image above. The software will fly you to each Placemark and sit on the extent
that you saved with each Placemark for a few seconds. You can stop the Virtual Field Trip at any time
to view the information that you added to each Placemark and then hit the Play Tour button again
(or use the tour toolbar at the bottom of your screen) to carry on. You can also double-click on any
one of the Placemarks in the menu above to fly straight to that location.
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Step 11: Sending Your Tour To Others

Finally you will want to be able to move your Virtual Field Trip to other computers for others to see
and use. This is also very easy to do as long as you have completed all steps above. Once you have
saved the .kmz file you can simply copy that file to a hard drive or USB drive and pass it on to your
colleagues or students. You can save the .kmz file to a website for people to download (you will find
many more online if you search, see below) or you can even email the file if there are no large
images associated with the .kmz file (some schools have strict limits on email download sizes). It is
important to create and share your Virtual Field Trips as there may be other educators who would
love to see what you have created.

i Title

Palm Island

Title

Northern Cyprus Flag Painted on a Mountain

File Palmisland.kmz File NorthernCyprusFlagPaintedOn...
3D Terrain 3D Terrain @
Group Landscapes Group Landscapes
Country Dubai Country Cyprus
Hits 2141 | Hits 3279
Copper Mine Title Morcott Crop Circle
1 CopperMine.kmz File MorcottCropCircle.kmz
3D Terrain & 3D Terrain
Group Landscapes Group Mystic
Country Chile Country England
Hits 4747 Hits 4139
i Title Mitchell Mesa Title Monument Valley

File MitchellMesa.kmz File MonumentValley.kmz
B8 3D Terrain & 3D Terrain &
Group Landscapes Group Landscapes
Country USA Country USA
Hits 4094 Hits 3487
| Title African village Title Namib Desert Mountain
File AfricanVillage.kmz File NamibDesertMountain.kmz
3D Terrain 3D Terrain &
Group Landscapes Group Landscapes
Country Sudan Country Namibia
Hits 4290 Hits 3753
Title Namib Desert Title Weird Thing & Beautiful Sand Formations

File
3D Terrain

NamibDesert.kmz

File
3D Terrain

WeirdThingAndBeautifulSandF...

Enjoy playing with Google Earth and make some time to practice — it is well worth the effort!




